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CREATE A QUIZ / INTERACTIVE 
EDUCATIONAL MEDIA IN LINUX WITH 
LIBREOFFICE IMPRESS
4/15/15 Source URL

Did you use Microsoft Powerpoint before? If you are a teacher, then you probably often 
create interactive educational media with it. Now you are using Linux. So how to use the 
tools available in your Linux to create similar thing? You can start with LibreOffice Impress 
to create interactive presentation. Including buttons and actions. I will show you the basic 
creation of such presentation. It is still simple but you can improve it to be more complex.

LibreOffice Impress Simple Quiz

What You Will Create

You will create a quiz in LibreOffice Impress. Given some question including the answer 
options as buttons. User chooses and clicks the button. If it is true, then user goes forward 
to next question. If not true, then go back to the beginning. It is similar with game.
The quiz consists of only 2 questions. Each question has two answer options. 
So there will be only 2 main slides, 2 hidden slides after first slide and 2 hidden slides after 
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second slide, and 1 opening slide. 
Total slides are 7. See picture below.

What To Do

1. Open LibreOffice Impress.
2. In this new presentation document, you will configure the behavior of the 

presentation. 
3. To do that, go to menu Slide Show > Slide Show Settings >  remove check from the 

option Change slides by clicking on background and Change slides manually. Make 
the options to be same with picture below.



4. Now create 1 slide for opening > 2 slides for question > 4 slides for hidden slides as 
the event results. See the sequences at the first picture above. You can make any 
question.

5. Now at the first question slide, slide number 2, after you write the question, create 
two rectangle shapes. Write the answer into each rectangle. They will be the answer 
buttons. See picture below. 

6. Do the point 5 for the second question slide, slide number 5. 
7. Now go to slide number 3. Make it hidden by right click > Hide Slide. 

8. Still in slide number 3, make it a correct result for question slide number 2. To do 
that, create two rectangles. First rectangle contains RIGHT! text and second contains 
GO FORWARD. See picture below.

9. Now go to slide number 4. Make it hidden by right click > Hide Slide.



10. Still in slide number 4, make it as incorrect result for question slide number 2. TO do 
that, do the same thing as point 8 but change the text into WRONG and GO BACK. 
See picture below. 

11. Now you should connect the buttons from slide number 2 with hidden slide number 
3 and 4. Assume the first button in slide 2 is correct one and second button is 
incorrect one. Then right click first button > Interaction > Go to page or object > 
select Slide 3. So connect correct button -> correct slide. See pictures below. 

12. Right click > Interaction > select slide destination. 
13. Now you should connect the incorrect button in slide 2 into slide number 4. Just 

repeat point 11. So connect incorrect button -> incorrect slide.
14. Until this, your presentation can connect the correct button to the correct slide, and 

the incorrect button to the incorrect slide. But it can not go back or go forward if it is 
false or true. Now you should create them. 



15. Now go to slide number 3. Right click GO FORWARD rectangles > Interaction > Go to 
page or object > select Slide 5. This will make your  presentation jump to the next 
question.

16. Insert Interaction / Event
17. Now go to slide number 4. Right click GO BACK rectangle > Interaction > Go to page 

or object > select Slide 1. This will make your presentation jump to opening slide.
18. Until this, you have a complete quiz for one single question. Now repeat point 5 until 

15 so you have a complete quiz for second question. Remember that 1 question slide 
needs 2 hidden slides. So 2 question slides need 4, 3 question slides need 6, and so 
on. 

19. Now go back to the first slide. Make this slide an opening slide. Just write your quiz 
title and create a rectangle shape > connect the rectangle to the first question (slide 
number 2).

20. Now test your quiz by viewing Slide Show (F5).

Conclusion

• Interactive presentation or quiz in LibreOffice Impress can be created by right click a 
shape > Interaction > select slide.  

• In every question, there are must be (at least) 2 hidden slides as the result.

Download ODP Examples

You can  download my ODP example I use to write this article.
• URL: http://bengkelubuntu.org/teks/libreoffice/Ubuntubuzz%20Interactive

%20Educational%20Presentation.odp 
• Size: 20 KB

http://bengkelubuntu.org/teks/libreoffice/Ubuntubuzz%20Interactive%20Educational%20Presentation.odp
http://bengkelubuntu.org/teks/libreoffice/Ubuntubuzz%20Interactive%20Educational%20Presentation.odp


CONTRIBUTE TO OPEN SOURCE 
COMMUNITY USING VIRTAAL
4/19/15 Source Link

Virtaal is a software to help you translating any open source software into your language 
easily. Virtaal is one of the best tool to do contribution for open source commmunity. You 
can use it for translating software user interface language. User interface language is the 
language appears in every aspect of your software GUI such as menu, button, notification, 
tooltip, and so on. You can use Virtaal to translate a software you love the most. I divide this 
article into three main parts. The main part is the first, how to do translation in Virtaal. The 
second part is an important part too, how to get the translation file. And the last part, how 
to send back the translation file you have done to the developer. This article is a global 
guide. You should be creative to implement it in another project host outside Launchpad. 

Virtaal in Action

What Software To Be Translated?

Try to translate only the software you love. The software you know best. Here are some 
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names.

• Synaptic Package Manager https://translations.launchpad.net/synaptic/main/
+lang/id 

• Blender 3D Modeller https://translations.launchpad.net/blender 
• Shutter Screenshot Tool https://translations.launchpad.net/shutter 
• Chromium Browser https://translations.launchpad.net/chromium-browser 
• OpenShot Video Editor https://translations.launchpad.net/openshot 
• PDFSAM PDF Merger https://translations.launchpad.net/pdfsam/+translations 
• Ubuntu Tweak https://translations.launchpad.net/ubuntu-tweak 
• Geany IDE https://translations.launchpad.net/geany 
• Bleachbit (CCleaner-like Tool) https://translations.launchpad.net/bleachbit 

I try to stay focus on Launchpad.

The Basic of Open Source Software Translation

You must know a few things about translation technically.

• String is every aspect of text that can be translated. Usually it is a line, a sentence, a 
phrase, a word, or maybe a letter.

• Every software can be translated into another language.
• Every language in every software saved in a .po file.
• Every software may has more than one .po file because a software project could be 

divided into parts, such as the main GUI and the plugin GUI and the documentation 
and so on.

• To translate a software, just edit the .po file.
• Get the .po file in Launchpad.
• I18N is internationalization, L10N is localization. The numbers represent how many 

letters between I and N or between L and N.   

Install Virtaal

By GUI, you can search virtaal in Ubuntu Software Center and install it. 

https://translations.launchpad.net/bleachbit
https://translations.launchpad.net/geany
https://translations.launchpad.net/ubuntu-tweak
https://translations.launchpad.net/pdfsam/+translations
https://translations.launchpad.net/openshot
https://translations.launchpad.net/chromium-browser
https://translations.launchpad.net/shutter
https://translations.launchpad.net/blender
https://translations.launchpad.net/synaptic/main/+lang/id
https://translations.launchpad.net/synaptic/main/+lang/id


By Terminal, you can use this command when internet connection is available: 

sudo apt-get install virtaal

Translating in Virtaal

1. Open Virtaal.
2. Open the .po file.
3. Left column is original language and right column is your translation place.
4. See that the empty line in the right column is the untranslated string.
5. Select the untranslated line by clicking on the line. You can start from the shortest 

line.
6. If you don't see any empty slot, you can see your top-left interface, at the Navigation, 

change the option into Incomplete. This will make Virtaal point you into the 
untranslated string.

7. Enter the translation on the empty box.



8. Press Enter to go to next string.
9. Translate what you can. Even it is just 3 lines.
10. Save your translation by Ctrl+S.   

Getting The Translation File

To get a translation file from Launchpad, you should have a Launchpad account. Log in into 
your account then follow these steps. I give an example for Shutter translation.

1. Go to the main project page of Shutter in Launchpad. You will visit the link 
https://translations.launchpad.net/shutter. 

2. See right panel. See Help Translate link.  

3. This link will bring you into language selection page. You will visit the URL 
https://translations.launchpad.net/shutter.  

https://translations.launchpad.net/shutter
https://translations.launchpad.net/shutter


4. Launchpad will show you the appropriate language for you. If you are Indonesian, it 
will show you only Indonesian link to translate. If you prefer another language, click 
the link View all languages at the bottom-right then select your language. I select 
Indonesian. This choice will bring you into translation templates page. The URL is 
https://translations.launchpad.net/shutter/trunk/+lang/id. 

5. In the template selection page, you will select whether you want to translate Shutter 
main interface, Shutter plugins interface, or Shutter upload plugins interface. It 
depends on the project, so you will experience different templates on another 
project. I select shutter here.  

6. This link will show you Shutter translation page. You will see the address 
https://translations.launchpad.net/shutter/trunk/+pots/shutter/id/+translate in here. 
To get the translation file, click the link Download translation at top-right of page. 

https://translations.launchpad.net/shutter/trunk/+pots/shutter/id/+translate
https://translations.launchpad.net/shutter/trunk/+lang/id


7. This link will show you the download page of translation file. Keep the option there 
PO format and click Request download button.  

8. Check your email soon. Launchpad sends you the translation file URL address into 
you email. Download the .po file. In my example, the file name is 
share_shutter_resources_po_shutter_shutter-id.po. 

9. You should request the download link for .po file

All projects in Launchpad generally have same steps to get the .po file.  

Uploading Translation File

After translating, you should upload your file into the official project website. In this case, 
you should upload it back to Launchpad. To upload a translation file, you should have a 



Launchpad account. It depends on the software project, it may require more steps for you 
to get upload right. But generally, you just need a Launchpad account. Just register to 
Launchpad and follow these steps.

1. Go to the Shutter translation page. You will visit 
https://translations.launchpad.net/shutter/trunk/+pots/shutter/id/+translate or such 
according your language choice.

2. Click the link Upload translation. 

3. This link will show you Upload Translation page. Click Choose file button and select 
your translated .po file. 

4. Then click Upload button.
5. Launchpad will show you a notification in that page. It says thank you for your 

translation effort. 

If you want you can see your upload status by clicking Translation Import Queue link. You 
will visit https://translations.launchpad.net/shutter/trunk/+imports.    

End

If you help translating, then you help many users in your country to use the software in 
their own language. For example, I am a Shutter translator for Indonesian Language. So, 
Indonesian Ubuntu users can use Shutter not in English but in Indonesian Language 
interface. 

https://translations.launchpad.net/shutter/trunk/+imports
https://translations.launchpad.net/shutter/trunk/+pots/shutter/id/+translate


MERGING PDF FILE IN LINUX WITH 
PDFSAM
4/19/15 Source Link

I have many PDF files. I want to collect them into one single PDF. I want to order them so my 
oldest PDF will be in the beginning, and the newest is in the end. How to do it in Linux? Just 
use PDFSAM. This article has two main parts. First, how to merge PDF files. Second, how to 
split a single PDF into many PDF according of its pages.

Merging or Splitting

Usage Examples

• You have Scribus. You produce a magazine with it. But you design the the page one 
by one (because of your resource limitation) in Scribus. Export them. Then merge 
them into a single PDF Magazine.

• You have downloaded many PDF from internet. You want to join them.
• You have written many ebooks. You want to join them.
• You have a PDF. You want to split it into pages.

Install PDFSAM

By GUI, you can open Ubuntu Software Center and search for pdfsam then install it.
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By Terminal, you can use this command when internet connection is available:

sudo apt-get install pdfsam

PDFSAM is a Java program. Installing it will bring Java JRE dependencies.

Merge PDF

1. Prepare your PDF files.
2. Open PDFSAM.
3. Click Merge/Extract on the left column.
4. Click Add button on the right column.
5. Select your PDF files here. Then Open.
6. Sort the order of PDF by selecting a PDF then clicking on arrow button (Move 

Up/Move Down) on the right side.
7. At the Destination output file, name your merged PDF. Or select your folder by 

Browse button.
8. Click Run button.
9. Check your destination folder. Your PDF is done.



Merging

Split PDF

Splitting



1. Open PDFSAM.
2. Click Split on the left column.
3. Click Add button on right column.
4. Select your PDF.
5. At the Split option, select Burst. This option will split your PDF into single pages.
6. At the Destination folder, select your folder.
7. At the Output options, it is best to remove the prefix.
8. Click Run button.
9. Check your folder. The result should be PDF files with ordered number filenames.   



WHAT TO DO AFTER INSTALLING 
UBUNTU
4/19/15 Source Link

There are common applications to install when you finished Ubuntu installation. Also, there 
are some common configurations you should do. I will give you a list of what applications 
and configurations with short explanations why you need them. I write this article based on 
my experiences in Indonesia Linux forums especially what people asks the most. This list is 
not a mandatory but people will need it for further Ubuntu usage. I write this article for 
beginners especially those who come from Windows. 

Prepare Your System

Preparation

A. Enable All Your Ubuntu Repositories

What to do: Open menu > look for Software & Updates > check all options except Source 
code option > choose your country server at Download from option > press Close button > 
press Reload button > let Ubuntu download all your repositories indexes > dialog windows 
will close after the download process completed. You need internet connection to do this. 

http://www.ubuntubuzz.com/2015/04/what-to-do-after-installing-ubuntu.html


Explanation: this activity is same with 1) editing /etc/apt/sources.list configuration file, 
activating Ubuntu restricted and universe repositories, and then 2) doing sudo apt-get 
update command. You just introduce your Ubuntu into what server it must use to download 
applications. Further, by just using Synaptic, you will do this easier. 

B. Shorten Your Ubuntu Commands

What to do: press Alt+F2 > type gedit .bashrc > enter following text > save. 

alias sagi='sudo apt-get install'  
alias saga='sudo apt-get autoremove'  
alias sagu='sudo apt-get update'  
alias sagr='sudo apt-get remove'  
alias acs='apt-cache search'  
alias pg='ping google.com'  

Explanation: this activity is same with editing $HOME/.bashrc file. You give permanent 
instruction to your Terminal (your bash shell) to understand your custom abbreviation 
commands. So, according to my above abbreviations, typing sagi in Terminal is same with 
sudo apt-get install and typing pg is same with ping google.com. It simplify my life, saves my 
keystrokes, and I use it everyday. It is just my example so you can create your own. 



Remember, this configuration is only applied for current user. So another user will not able 
to use these abbreviations. 

What To Do

1. Install Synaptic

What to do: type this command in the Terminal:

sagi synaptic  

It is same with sudo apt-get install synaptic.

Explanation: my main rule so I create this article is my principle "install Synaptic first and 
you can learn what you want after that". I give package management system the highest 
place in Ubuntu learning for beginners. Canonical removed Synaptic, gave you Ubuntu 
Software Center (USC), but Synaptic is better to learn and far better to solve problems 
further. You can add / remove program, configure your repositories even PPA, you can fix 
broken packages, you can create Synaptic download script (for offline user) and you can 
configure proxy + authentication connection with Synaptic. You can not completely do 
those with USC. 



Extra: you should pin Synaptic into Ubuntu sidebar (launcher). To do it, open Synaptic > right 
click on the Synaptic icon on the launcher > Lock to launcher.

2. Install GDebi

What to do: type this command in the Terminal:

sagi gdebi  

This is same with sudo apt-get install gdebi.

Explanation: this will command apt to download and install GDebi. DGebi is an ultimate GUI 
helper for Synaptic. GDebi handles single DEB packages. GDebi used to install DEB package 
such as FlareGet or uGet you download from the its official site. GDebi has a sophisticated 
feature to read DEB package and search for the dependencies and install it automatically. 
You will need GDebi for further Ubuntu usage. Remember that you must did Preparation 
point A before installing GDebi because it is in the Ubuntu universe repository. 

Extra: how to use GDebi? Just see picture below.

Right click on DEB file > Open With > GDebi



3. Install Multimedia Codec

What to do: type this command in the Terminal:

sagi ubuntu-restricted-extras  

Explanation: Ubuntu can not play MP3 or MP4 by default. You should install the multimedia 
codecs by yourself. All codecs you need is available by installing the ubuntu-restricted-
extras package. 

4. Install Ubuntu Tweak

sudo add-apt-repository ppa:tualatrix/ppa  
sudo apt-get update  
sudo apt-get install ubuntu-tweak  

If Terminal asks you something, answer by Enter button.  

Explanation: in Windows, you are maybe familiar with TuneUp Utilities. In Ubuntu, you get 
the same functionality by using Ubuntu Tweak. You can configure Ubuntu appearance, 
cleaning unused cache, change system behaviors, and even add/remove applications. 



5. Install Wine

What to do: type this command in the Terminal:

sagi wine  

This is same with sudo apt-get install wine. When installing, a dialog inside your Terminal 
(ncurses) will appear asking for your agreement for EULA. You can not click it. To get the 
cursor into OK button, press TAB button. Then press Enter to click it.



After installing, search Wine in your menu.

Explanation: this command will install Wine from official Ubuntu repository. Any Windows 
user in Linux usually needs Wine. Wine is a program to run Windows applications (office 
suites, multimedia, games, and so on) in Linux. Yes, you can run Windows applications in 
Linux by Wine.



Extra: how to use Wine? Once installed, look for your EXE file. Right click the EXE file > 
select Open With Wine Windows Program Loader. 

6. Install GParted 

What to do: type this command in the Terminal:

sagi gparted  

This is same with sudo apt-get install gparted. 

Explanation: you will always need to manage your HDD partitions. Whether resizing, 
deleting, adding, manipulating the filesystem, formatting, or something else. One of the 
most advanced tool in Linux to do that is GParted. You should have it. 



7. Install Alacarte

What to do: type this command in the Terminal:

sagi alacarte  

This is same with sudo apt-get install alacarte.

Explanation: in Windows, you can easily edit Windows menu (taskbar) entry one by one. 
Whether adding a program icon or removing it. In Ubuntu, by default, you can not do it. The 
easiest way to edit Ubuntu menu is by using Alacarte. You can add, remove, edit, change 
icon, and so on for your menu. For example, you can add your own program and its icon so it 
appears in Ubuntu menu. 

8. Install Wvdial

What to do: type this command in the Terminal:

sagi wvdial  

This is same with sudo apt-get install wvdial. 

Explanation: Wvdial is a program to connect USB modem to the internet. If you live at a 
country when USB modems usage (Mobile Broadband CDMA/GSM) is the majority among 
desktop users, then the biggest possibility is you need wvdial. There are so many USB 



modems need specific configuration in Linux, for example ZTE AC682. Almost all tutorials 
provided in the internet teach wvdial to the readers. So it is reasonable to have wvdial 
installed.

End

Each of you has different needs. I just write the most common preparations according to my 
own experience. As you can see, I do not write Java, sudo apt-get upgrade, and any 
download manager here. I assume they are your own rights to choose. That was all. 



CREATE MULTIBOOT OS USB WITH 
MULTISYSTEM IN LINUX
4/20/15 Source Link

We can make a bootable USB flash drive containing more than one operating system. This 
drive called multiboot drive. You can make it from Linux by using Multisystem. I show you 
how to use Multisystem to create Ubuntu, elementary OS, Fedora, and Antergos inside a 16 
GB USB drive.

Multisystem

Install Multisystem

To install Multisystem, you need to enable all your repositories. See What To Do article at 
preparation section.

After enabling them all, now do these commands.
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sudo apt-add-repository 'deb http://liveusb.info/multisystem/depot all main'  
wget -q -O - http://liveusb.info/multisystem/depot/multisystem.asc | sudo apt-key 
add -   
sudo apt-get update  
sudo apt-get install multisystem  

Explanation: to install Multisystem, we need 4 commands. First command above tells 
Ubuntu to add Mutisystem Debian Repository. Second command tells Ubuntu to get 
verification key for security (to make sure that the repository is correct). Third command 
tells Ubuntu to reset the repositories list so the new repository added (Multisystem) will be 
used for further. The last command installs Multisystem.

Installing Multisystem and Dependencies

Burn Linux ISO Images To The Drive

1. Insert your USB drive to USB port. Mount it. 
2. Open Multisystem. 
3. Multisystem main window will detect your USB drive. In this example, I use Kingston 

DataTraveler. So it detects the same device. If it doesn't detect it on your machine, 
mount the drive and click the reload button.  



4. Then select your drive and click Confirm button.
5. A dialog will appear saying that the Grub2 will be installed in MBR. It means 

Multisystem will install bootloader into your USB drive (not HDD). Click OK. 

6. Now you see a blank Multisystem window like this.  



7. Click the disc icon below Select an .iso section to open ISO file. 
8. Select ISO file.  

9. A black window will appear. It is a Terminal asking you for your password. Enter it.



10. The terminal will do the burning process. Wait until finished. 

11. Repeat points 7 - 10 for another ISO. 
12. The result in Multisystem is it reads your drive to has 4 operating systems like this. 



Multisystem Reads My Drive Contents

Bonus

Actually when you install Multisystem, you will install QEMU dependencies too. By using 
QEMU, you can try your USB without restarting nor testing on another machine. QEMU is a 
great virtualization hypervisor. It is relatively lighter than Virtualbox. Just go to main 
window > Boot Tab > click Test your liveusb in QEMU. See picture below.

Testing The Drive with QEMU Virtualization



KEEP YOUR ACCOUNT PASSWORDS WITH 
KEEPASSX
4/20/15 Source Link

KeePassX is a cross-platform password manager. It is licensed in GPL2. And it is available in 
Ubuntu official repository. A password manager like KeePassX is important if we often 
forget our own passwords. This article will show you how to install KeePassX in Ubuntu and 
how to use it.

KeePassX

Install KeePassX

By GUI, you can search for keepassx in Ubuntu Software Center and then install it:

http://www.ubuntubuzz.com/2015/04/keep-your-account-passwords-with-keepassx.html


By Terminal, type this command and let Ubuntu install KeePassX:

sudo apt-get install keepassx

How To Use It

1. Open KeePassX. 
2. Create new database.

3. Create new master password.



4. Reenter your new master password.
5. Now you get KeePassX show you basic account database. It is still empty.
6. To insert your account into KeePassX, add new entry. 

7. Insert your username and password into your new entry. For example, to create an 
entry for your Gmail account, see picture below. 



8. Click OK to create that entry. 
9. Now you see a new entry in your KeePassX database. 
10. You can create more entries by repeating points 6 - 8.
11. Save your database by menu File > Save Database.

When You Forget A Password



Now when you forget a password, open again your KeePassX. And open the entry you 
saved. Click the eye icon besides password box to reveal your password. Make sure nobody 
besides you when you do it. 



HOW TO INSTALL UBUNTU PPA WITH 
SYNAPTIC
4/20/15 Source Link

Installing and removing a PPA in Ubuntu is easy with GUI. If you usually install and remove a 
PPA via Terminal, then actually you can do it easier with Synaptic Package Manager. That is 
why we recommend Synaptic to you before. This article will show you how to do PPA 
installation in Ubuntu with Synaptic including the explanations.

Synaptic Managing PPA

Get A PPA Address

The main point of any software installation is getting installation source. You should know 
PPA address to install a software from PPA. Now I give you example a PPA tutorial for 
Shutter.

sudo add-apt-repository ppa:shutter/ppa  
sudo apt-get update  
sudo apt-get install shutter  

Where is the address? The address is the tail of first command ppa:shutter/ppa. This is the 
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PPA address. And it is same for all softwares for Ubuntu in the PPA. It is already 
standardized.

You can find a PPA address in everywhere

You can get the example for SimpleScreenRecorder (ppa:inkscape.dev/stable), OpenShot 
(ppa:openshot.developers/ppa), GIMP (ppa:otto-kesselgulasch/gimp), Inkscape 
(ppa:inkscape.dev/stable), and so on. Look at the similarity of those addresses. They always 
started with ppa: prefix and has "subdirectory" after / (slash). You can find them in every 
tutorial in the internet or by just visit their Launchpad PPA pages. Now you know how to get 
PPA address.

Enter The PPA Address

1. Open Synaptic. 
2. Open menu Settings > Repositories > open tab Other Software.
3. At that tab, click Add button. 
4. Now paste your PPA address into the text box. Then click Add Source. 

5. A dialog asking you to Reload will appear. Just click reload. This will reset your 
repositories list so Ubuntu will know there is a new repository you add from PPA. 



6. Synaptic will do reloading. It will download all repositories indexes including your 
new PPA. Wait until finish. 

7. Now search the name of software from your PPA. I give you example inkscape 
because I used Inkscape PPA. 



8. Install the software if you want. 
9. Explanation: actually, what you do in Synaptic like those above is exactly same with 

doing sudo add-apt-repository ppa:address && sudo apt-get update && sudo apt-get 
install ppa-program commands in Terminal. If you are not familiar with Terminal, then 
Synaptic is far better for you. 

WARNING: after adding, enabling, disabling, or removing a PPA, you must Reload or sudo 
apt-get update or your system may be broken. It is because Reloading will point your 
Ubuntu into the current repository it is using, whether it is official or PPA.

Remember This Button

Disable A PPA Address



Maybe you want to just enable the PPA so Ubuntu will point to official repository instead 
and so the PPA address does not removed. To do it, follow these steps.

1. Open Synaptic. 
2. Open menu Settings > Repositories > open tab Other Software. 
3. Uncheck the PPA you want to disable. 
4. Reload. Remember, reloading is mandatory.
5. Explanation: disabling a PPA address is actually just adding # sign in the sources.list 

for the PPA. The sources list for any PPA saved in /etc/apt/sources.list.d/ directory. 
And disabling a PPA means to type # sign in every line in the .list file there. In Linux 
scripting, # sign means comment (unused). See picture below.

Files in /etc/apt/sources.list.d/ are always corresponding with your PPA repos

Remove A PPA Address

A PPA is actually a single repository. More PPA you install, it means more repositories you 
give for your Ubuntu. So, sudo apt-get update will need more times and more internet 
bandwidth. How if you want to remove a PPA? Follow these instructions.

1. Open Synaptic. 



2. Open menu Settings > Repositories > open tab Other Software. 
3. Select the PPA you want to remove. 
4. Click Remove button. 
5. Reload. Remember, reloading is mandatory. 

Explanation: actually when you press Remove button, you delete all text inside 
corresponding file in  /etc/apt/sources.list.d/ directory. The file is there, not removed. But 
its contents are removed. If you remove all PPA, then all files will be emptied. See picture 
below.

I removed all PPA repos, so all files in /etc/apt/sources.list.d/ are empty



HOW TO INSTALL TELEGRAM DESKTOP 
IN UBUNTU
4/20/15 Source Link

Telegram is a new chatting protocol similar to WhatsApp. Telegram is open source software 
licensed in GNU GPL version 3. The main great feature of Telegram that WhatsApp doesn't 
have is Linux desktop client. This tutorial will guide you step by step how to install it in 
Ubuntu.

Telegram Desktop for Ubuntu

1. Visit Telegram Website

http://www.ubuntubuzz.com/2015/04/how-to-install-telegram-desktop-in-ubuntu.html


The address is https://desktop.telegram.org/. 

2. Download Telegram Package

Click the blue Download button (Get Telegram for Linux). It should download a package file 
with .tar.xz extension. It is a compressed file. 

3. Extract The Package

Right click on that package > Extract Here. Then you get a folder named Telegram. Open 
that folder.  



4. Double Click Telegram Executable

You get two executable files. One named Telegram (the installer program) and one named 
Updater (the program updater). Double click Telegram. 



Ultimately Easy Installation

5. Telegram Installed Successfully



Installed

Wait until Telegram main window appears. It means your Telegram has installed 
successfully. You can see your Ubuntu menu to open Telegram later. 



DIRECT LINK GOOGLE IN CHROMIUM 
AND FIREFOX
4/21/15 Source Link

Google actually will track every your click in the search result page. Google redirects all 
links. So you never get the real URL when doing Copy Link Location. So how to remove that 
Google behavior in Chrome/Chromium and Firefox? How to protect yourself from this 
Google indirection? You just need the right add-ons.

Freedom To Copy A Link

Chrome/Chromium
Install Don't track me google extension.

• Open https://chrome.google.com/webstore/detail/dont-track-me-
google/gdbofhhdmcladcmmfjolgndfkpobecpg. It is the extension official at Chrome 
Web Store.

• Click Add To Chrome button. 
• Try to do googling and copy link address some links. 

https://chrome.google.com/webstore/detail/dont-track-me-google/gdbofhhdmcladcmmfjolgndfkpobecpg
https://chrome.google.com/webstore/detail/dont-track-me-google/gdbofhhdmcladcmmfjolgndfkpobecpg
http://www.ubuntubuzz.com/2015/04/direct-link-google-in-chromium-and-firefox.html


Firefox
Install Google search link fix add-on. 

1. Open Firefox. 
2. Open menu Tools > Add-ons or by shortcut Shift+Ctrl+A. 
3. Search the name google search link fix. 
4. Install that add-on. 
5. Try to do googling and copy link location some links. 



HOW TO READ PDF IN CHROMIUM
4/21/15 Source Link

Now you can read PDF directly inside Google Chrome or Chromium. It is just same with 
Firefox built-in PDF reader. To get it, you need to install a Chrome extension named PDF 
Viewer. This extension created by Rob Wu and friends. This extension is available in Chrome 
Web Store. The development page of PDF Viewer is on Github (if you want to contribute). 
This extension is compatible both in Chromium or Google Chrome. 

View PDF in Chromium Browser

There are some benefits from reading PDF inside Chromium:

1. You do not need to wait Okular or Evince in Linux to has multitab support. 
2. You get a multitab PDF reader in Linux just same as Foxit PDF Reader in Windows. 
3. You just read any PDF on the net inside Chromium, no redundant work.
4. You can also download the PDF.
5. You can read any PDF when you are offline.

  

Install PDF Viewer

1. Open Chromium.
2. Open the PDF Viewer store page.  

http://www.ubuntubuzz.com/2015/04/how-to-read-pdf-in-chromium.html


3. Click Add To Chrome button.
4. Wait until it finished. 
5. Try to open any PDF link or open PDF from your files.

Open Debian Packaging Guides PDF in Chromium



I-NEX, AN ADVANCED CPU-Z HARDWARE 
UTILITY FOR LINUX
4/21/15 Source Link

Do you want CPU-Z in Linux? Then see I-Nex now. I-Nex is system utility tool for Linux. It 
shows you all your hardware plus you operating system and kernel detailed information. I-
Nex is created for Linux with Gambas 3 platform. It is licensed in GNU LGPL version 3. I-Nex 
is a software by Michal Glowienka. If you want to contribute, visit I-Nex on 
https://github.com/eloaders/I-Nex. If you want to translate I-Nex, visit 
https://translations.launchpad.net/i-nex.  

I-Nex Features

How To Install I-Nex 

Open Terminal and type these 4 commands one by one. If Terminal asks for Enter, then type 

https://translations.launchpad.net/i-nex
http://www.ubuntubuzz.com/2015/04/i-nex-advanced-cpu-z-hardware-utility-for-linux.html


Enter.

sudo add-apt-repository ppa:gambas-team/gambas3
sudo add-apt-repository ppa:i-nex-development-team/stable
sudo apt-get update
sudo apt-get install i-nex

Explanation: those commands above will introduce first Gambas 3 PPA repository to 
Ubuntu, then introduce I-Nex PPA, then reload all repositories including the two added so 
Ubuntu knows there are new repositories, then finally install I-Nex. I-Nex needs Gambas 3 
dependencies because it created by using Gambas 3 library. 

How To Use I-Nex (Basic)

At basic usage, it is same with CPU-Z. You just open it from the menu and see what you 
want to see. You get CPU, GPU, Audio, Memory, Kernel, System (OS) tabs. In every tab, you 
can see detailed information of each hardware.



Detailed Hardware Information

From picture above, I-Nex at CPU tab, we know that my processor is Intel Celeron B800 800 
MHz. My current processor temperature is 65 ºC. My processor supports 64 bit instructions 
(indeed, I can run 64 bit Linux). My processor codename is Sandy Bridge. And many more 
detailed information. 

How To Dump Your System Information

To dump (save to plain text) all information from I-Nex, you can use Generate Report 
feature. You can select one information (CPU, GPU, or else), two, or all. You can also include 
all information from basic system utility such as lspci just from a single window. The result 



of this feature is a text file containing all information you want.

Generate Report Button

Dumping To Text File

Dumping all system information is useful especially if you need to collect them into a single 
file. Or maybe if you need to create a database from them. Somebody ever worked in 
database dumping will understand it.

Cerbero

I-Nex created for us, Linux users. But further, Michal (the I-Nex developer) created a web 
service to collect hardware information from Linux users. The web service is named 
Cerbero. The idea is simple: Linux users install I-Nex -> I-Nex collect the detailed 
information -> I-Nex sends the information to Cerbero. I have submitted my hardware 
information to Cerbero. So with Cerbero, further, Linux users will know what hardware or 
laptop is compatible with Linux.



Validate Button

To submit the information, you can just press Validate button in I-Nex CPU tab when 
connected to the internet. Then I-Nex will collect all information quickly and send them to 
Cerberos. You will see a dialog showing an URL. That is your page for your detailed system 
information. See picture below.

My Cerbero

Reference

http://i-nex.linux.pl/install/ 

http://i-nex.linux.pl/install/


DIM SCREEN BRIGHTNESS IN UBUNTU 
WITH REDSHIFTGUI
4/22/15 Source Link

Do you want to decrease your screen brightness? Have tried all the ways but failed? Use 
RedshiftGUI to dim your screen. I always recommend RedshiftGUI to Indonesian Linux users 
as a "final combo" when installing graphics driver or upgrading Linux kernel brings nothing 
to their screen brightness. I will show you the steps to install, dim screen, and set 
RedshiftGUI to Ubuntu startup.

ReshiftGUI

Install RedshiftGUI
1. Download RedshiftGUI DEB package from 

https://github.com/maoserr/redshiftgui/downloads. 
2. Choose Linux 32 bit or Linux 64 bit package. Ignore all else.
3. Download into your Home folder.  

https://github.com/maoserr/redshiftgui/downloads
http://www.ubuntubuzz.com/2015/04/dim-screen-brightness-in-ubuntu-with-redshiftgui.html


4. Open Terminal. 
5. Type command sudo dpkg -i Red
6. Press TAB button. So, Terminal completes the command automatically into sudo 

dpkg -i RedshiftGUI-0.2.1-Linux-i686.deb
7. Press Enter. 
8. Type your password. Don't wait for asterisk sign. No asterisk inside Terminal.
9. Wait until dpkg finished the installation.



How To Use RedshiftGUI

1. Open RedshiftGUI. 
2. Slide the slider to left, so the brightness decreased. You decide where. 
3. You can close the ReshiftGUI window. 

How To Add RedshiftGUI as Startup Items

1. Open Startup Applications from menu.
2. Once opened, click Add button.
3. Type in Name box, RedshiftGUI. 
4. Type in command, redshiftgui. Press Add. See picture below. 
5. Try to relogin or restart to take effect. 



About RedshiftGUI

RedshiftGUI is actually an open source software to change the color of your screen to match 
your environment automatically. It was not intended to change the brightness. But in the 
reality, Redshift is so useful to do it. Redshift is licensed under GNU GPL version 3. Redshift 
is a software created by Mao Yu. You can visit Redshift Sourceforge project or Github 
project to contribute.



HOW TO INSTALL UNETBOOTIN IN 
UBUNTU
4/22/15 Source Link

Unetbootin is a burning tool for ISO to create bootable USB drive. It is open source and 
licensed under GNU GPL version 2. Unetbootin is a software by Geza Kovacs. Unetbootin 
official site is on Sourceforge, Launchpad Translations, and it has Github page (if you want 
to contribute). This article will show you how to install and use Unetbootin on Ubuntu.

Unetbootin Main Window

How To Install Unetbootin

By GUI, you can search unetbootin on Ubuntu Software Center.

http://www.ubuntubuzz.com/2015/04/how-to-install-unetbootin-in-ubuntu.html


By Terminal, type this command

sudo apt-get install unetbootin  



How To Use Unetbootin

Unetbootin in Menu

Simply, insert your USB drive > open Unetbootin from menu > enter your password > 
Unetbootin appears > select Diskimage > select your ISO image file > make sure the Type is 



USB Drive not Hard Disk > and the drive is /dev/sdbX (or anything for your USB drive) > click 
OK. Wait until the process finished. See picture below.

Focus on Bottom

Interesting Things About Unetbootin

I use Unetbootin to burn anything into my USB drives. I use it to create Fedora, Ubuntu, 
Linux Mint, Blankon, Slackware bootable USB, until I can not count anymore how many 
times I've been used it. Even Unetbootin can burn Hiren's Boot CD image into my flash 
drive. All them work. So we can see now that Unetbootin is usable to create any operating 
system bootable USB drive from Linux. 

More interesting thing is Unetbootin can create your bootable persistent. So, even it is just 
a bootable liveusb, you can save your changes inside the OS in the USB drive. That is 
persistent technology. You can enable persistent by giving Space used to preserve... section 
a value. How many MB for your persistent storage inside the OS in the USB drive. See 
picture above. 



HOW TO BURN ISO DVD WITH K3B
4/22/15 Source Link

Ubuntu has a default CD burning program called Brasero. But for my DVD productions, I 
changed Brasero for K3B. I found that K3B is faster and more reliable. K3B is same with 
Brasero, a CD burning program. Now I want to show you how to install K3B and how to burn 
an ISO image to DVD with K3B. I use external DVD writer to do it.

K3B In Action

How To Install K3B

By GUI, you can search k3b in Ubuntu Software Center.

http://www.ubuntubuzz.com/2015/04/how-to-burn-iso-dvd-with-k3b.html


By Terminal, you can use this command.

sudo apt-get install k3b  

How To Burn ISO 

1. Open K3B. 
2. Open menu > Tools > Burn Image. 



3. In the new Window, select your iso by clicking the folder icon. 

4. Select the burn speed. It is better to select lower speed to decrease the burning 
failure risk. 



5. If all options are OK, click Start button. The burning progress will appear in new 
window. 

6. When burning is finished, the window will show Success message. Then check your 
finished DVD now. 



USE PINTA TO ANNOTATE IMAGE IN 
LINUX
4/22/15 Source Link

Pinta is an cross-platform image editor inspired by Paint.NET in Windows. It is lighter than 
GIMP, but more than Shotwell or Gwenview. Pinta is licensed under MIT license. Pinta is a 
software by Pinta Project (Cameron White and friends). This article will guide you how to 
install and use Pinta in Ubuntu. I will show you the basic usage only to crop and annotate 
image. I write this article based on my experiences in writing Linux tutorials.

Pinta In Action

Pinta Basic Usages

You can use Pinta for image editing stuffs below. 

1. Painting. 
2. Cropping. 
3. Annotating. 
4. Censoring. 
5. Applying filter effects.
6. And more.

http://www.ubuntubuzz.com/2015/04/use-pinta-to-annotate-image-in-linux.html


How To Install Pinta
By GUI, you can search pinta in Ubuntu Software Center.

By Terminal, you can use this command.  

sudo apt-get install pinta  

Crop Image

1. Open the image. You can do it by open file manager > right click on the image file > 
Open With > Pinta. 

2. Click on Rectangle Select Tool. 
3. Now select rectangle area inside the image you want to crop.
4. Click button Crop to Selection.
5. Save the image (Ctrl+S).



Annotate Image

This is the important technique to make the readers understand. I use it frequently.

1. Open the image. 

2. Select Rectangle Tool. 
3. Select Color. Usually I use Red color.  

4. Select Brush Width. Usually I use 5 in Ubuntubuzz. 



5. Drag the tool on your canvas. Make it clear to your reader. 

6. Save the image. 



UBUNTU 15.04 VIVID VERVET RELEASED
4/26/15 Source Link

Finally, at April 23rd 2015, Ubuntu 15.04 Vivid Vervet officially released. Actually, no big 
changes except systemd is officially implemented in Ubuntu 15.04. We get some new 
updated applications, a new official web browser by Ubuntu, small Unity improvements, and 
some others. You will get download links, some reviews, and what to do after install in this 
article. Enjoy!

Ubuntu 15.04 Vivid Vervet Login Screen

Release Date

Here is a table of Ubuntu current releases. You should note that Ubuntu 15.04 released this 
month and will experience the end of life (no support again) in January 2016. Ubuntu 15.04 
is released as regular release, it means it will get official support only for 9 months.

Version Code Name Support Duration Release Date End of Life Date

Ubuntu 15.04 Vivid Vervet Regular (9 months) April 23, 2015 January 2016

Ubuntu 14.10 Utopic Unicorn Regular (9 month) October 23, 2014 July 2015

Ubuntu 14.04 Trusty Tahr LTS (5 years) April 17, 2014 April 2019

Ubuntu 12.04 Precise Pangolin LTS (5 years) April 26, 2012 April 2017

Ubuntu 10.04 Lucid Lynx LTS (5 years) April 29, 2010 May 9, 2013

https://lists.ubuntu.com/archives/ubuntu-announce/2013-March/000169.html
https://lists.ubuntu.com/archives/ubuntu-announce/2010-April/000133.html
https://lists.ubuntu.com/archives/ubuntu-announce/2012-April/000159.html
https://lists.ubuntu.com/archives/ubuntu-announce/2014-April/000182.html
https://lists.ubuntu.com/archives/ubuntu-announce/2014-October/000191.html
https://lists.ubuntu.com/archives/ubuntu-announce/2014-October/000191.html
https://lists.ubuntu.com/archives/ubuntu-announce/2015-April/000195.html
https://lists.ubuntu.com/archives/ubuntu-announce/2015-April/000195.html
http://www.ubuntubuzz.com/2015/04/ubuntu-1504-vivid-vervet-released.html


Download

You can download Ubuntu 15.04 and its official variants from these links.

Download Ubuntu

• Ubuntu: http://releases.ubuntu.com/15.04/ 
• Kubuntu: http://cdimage.ubuntu.com/kubuntu/releases/15.04/release/ 
• Lubuntu: http://cdimage.ubuntu.com/lubuntu/releases/15.04/release/ 
• Xubuntu: http://cdimage.ubuntu.com/xubuntu/releases/15.04/release/ 
• Ubuntu MATE:  http://cdimage.ubuntu.com/ubuntu-mate/releases/15.04/release/ 
• Ubuntu GNOME: http://cdimage.ubuntu.com/ubuntu-gnome/releases/15.04/release/ 
• Ubuntu Studio: http://cdimage.ubuntu.com/ubuntustudio/releases/15.04/release/ 
• Ubuntu Kylin: http://cdimage.ubuntu.com/ubuntukylin/releases/15.04/release/ 

I downloaded Ubuntu 15.04 via BitTorrent. I recommend you to use BitTorrent too (use 
Transmission or KTorrent in Linux) so you contribute not big load to the download servers. 
All links above provide torrents too. 

What's New

1. Vivid Wallpapers

Ubuntu opened wallpaper contest for Vivid in Flickr. The finalists have selected and Ubuntu 
has new wallpapers in Vivid release. You can use them in Vivid or for you can download the 

http://cdimage.ubuntu.com/ubuntukylin/releases/15.04/release/
http://cdimage.ubuntu.com/ubuntustudio/releases/15.04/release/
http://cdimage.ubuntu.com/ubuntu-gnome/releases/15.04/release/
http://cdimage.ubuntu.com/ubuntu-mate/releases/15.04/release/
http://cdimage.ubuntu.com/xubuntu/releases/15.04/release/
http://cdimage.ubuntu.com/lubuntu/releases/15.04/release/
http://cdimage.ubuntu.com/kubuntu/releases/15.04/release/
http://releases.ubuntu.com/15.04/


wallpapers pack from Launchpad (14 MB).

Ubuntu Default Wallpaper Tenerife Roques de Anaga

2. Unity 7.3

Ubuntu 15.04 gets Unity 7.3 and Compiz 0.9.12. In Unity, we get local menu on every 
window as the most notable feature. In Compiz, we get bug fixes for NVIDIA proprietary 
driver.

Application Menu in Window Title Bar



3. LibreOffice 4.4

LibreOffice 4.4 brings many improvements such as version tracking in Writer, more statistic 
functions in Calc, OpenGL support for slide transition in Impress, many bugfixes, and so on. 
You can read the details from https://wiki.documentfoundation.org/ReleaseNotes/4.4. 

LibreOffice 4.4

4. Kernel 3.19

Ubuntu brings Linux kernel 3.19, which is modified kernel by Ubuntu Team (as usual). It is 
not the latest Linux kernel (4.x). You can read easy-to-understand details about 3.19 in 
http://kernelnewbies.org/Linux_3.19.  

Vivid Linux Kernel Version

5. Systemd

SystemD replaced Upstart in Ubuntu 15.04. All Ubuntu variants (except Ubuntu Touch) has 

http://kernelnewbies.org/Linux_3.19
https://wiki.documentfoundation.org/ReleaseNotes/4.4


used systemd as default init system. SystemD, Upstart, SystemV, are the names for init 
system. An init system is the first process initialized among all processes in the Ubuntu 
system. SystemD handles the init system for Ubuntu now, replacing old systemV-like init 
system such as Upstart. Beyond the big debates about systemd outside, you will find your 
Ubuntu starts faster with it. You can read about systemd in 
http://en.wikipedia.org/wiki/Systemd. 

SystemD

6. Nautilus 3.14.2

Beside GTK 3.14 library, Ubuntu 15.04 brings also Nautilus 3.14.

Nautilus

http://en.wikipedia.org/wiki/Systemd


What I love about the new Nautilus is its incremental search. Incremental search is similar 
with Google Instant. You get the result without pressing Enter button. The results come 
according to your keyword directly. Incrementally, when you type a new letter, the result 
will change again according to your current keyword. It is fast.

Incremental Search

7. Another Applications

Ubuntu 15.04 brings another updated applications such as

1. GTK Library 3.14
2. Shotwell 0.20.2
3. Firefox 37.0
4. Thunderbird 31.6.0
5. Cheese 3.14.1
6. Transmission 2.84
7. Remmina Desktop Client 1.1.0
8. Ubuntu Browser 



GTK Libraries

What To Do After Install

After installing Ubuntu, usually you need to enable all your official repositories first via 
Software Sources program. Then Reload (sudo apt-get update) the repository information 
so Ubuntu knows all repositories are enabled. Probably you want to change the server into 
your local server at your country too. Do it in Software Sources. 



Repository Indexes Reloading

After you get all your repositories enabled, then now I advised you (desktop users) to install 
Synaptic. It is easier to add/remove applications. Easier to upgrade packages, easier to 
create offline dependencies download script, and to fix any dependencies conflict.

Synaptic

After having Synaptic, you can do what do you want. Install codec pack (ubuntu-restricted-
extras), Wine (wine), GIMP (gimp), VLC (vlc), and even you may upgrade your whole system. 



It is up to you (and do anything with your own risk).

We have a complete article about what to do after install here. 

http://www.ubuntubuzz.com/2015/04/what-to-do-after-installing-ubuntu.html
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